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Change Log
Version Latest Status Date Description of Change
v5.12 Approved 25 Mar 2011 The following changes have been made to this version:

• 7.1 Further modifications to highlight changes in uploading a document 
involving Document Type; 
• 9.22 Clarification of the availability of HTML format of a document.

v5.11 Approved 14 Feb 2011 The following chnages have been made in this version:
• 7.1 Modifications to text to highlight changes in uploading a document 
involving Document Type; 
• 9.12 Clarification of the feature, Folder Notifications; see also sections 9.10 
and 9.11; 
• Corrections based on reviewers’comments of previous version.

v5.10 Approved 10 Jan 2011 The following changes have been made in this version:
• 7.1 Uploading a document file and setting its metadata (selecting Document 
Type as the first step) 
• 9.5 Changing Document Type 
• 9.24 Modification to “Generated From” 
• 9.28 Next Expected Version Date

v5.9 Approved 13 Dec 2010 The following change has been made in this version:
• 5.1.1 Correction of formatting error in text

v5.8 Signed 10 Dec 2010 The following changes have been made to this version:

    5   Select coverpage template has been removed from folder setup as 
templates may now be related to the the document type
    5.2.5   Folder ROs can set subscribers to a folder who will automatically 
receive email notification of additions and modifications within the folder
    7.1   When uploading documents the mandatory fields may now be 
configured according to document type rather than the same configuration for 
all uploads
    8.8   The role of the IDM project administrator included

v5.7 Approved 08 Nov 2010 The following changes have been made in this version:
• 7.3 Pasting into Text fields (new item in Manual only);
• 9.8 Send Mail;
• 11.1 Giving Permissions to Groups

v5.6 Signed 28 Oct 2010 The following changes have been made in this version: 
• 5.2.2   Security note: project administrator;
• 9.10, 9.11   Document notifications set on document types and folders;
• 11.1   Changes to the set security page.
Following reviewers’ comments on the previous versions of this Manual, text 
and /or screen shots have been modified in the following sections: 
• 3 ICP Home Page; • 5.1.1 Main Folders (yellow); • 6.1 Creation of 
Hyperlinks; • 7.1 Uploading a document file and setting its metadata; • 8 
Stakeholders and their Actions; • 9.1 Status of Documents; • 9.5 Changing 
Stakeholders; • 9.25 Modifying Change Description of New Version; • 10.1 
Simple Search 10.2 Advanced Search.

v5.5 Approved 19 Aug 2010 In this version all page borders have been removed.  Please also note the 
changes made for version 5.4:
• 7.1 Uploading a document: selecting from a pre-determined list searching or 
by opening a tree structure; 
• 9.21 Documents can be linked via a new ‘generated from’ property when they 
are related but one does not supersede the other; 
• 9.25 Documents under configuration control do not need SECM approval for 
the ‘Approve’ action. Justification must be given to SECM for the creation of 
requests; 
• 10.2 Changes to the Advanced Search interface; Note: screen shots have been 
updated throughout the Manual.

v5.4 In Work 18 Aug 2010 Changes have been made to the following sections:
• 7.1 Uploading a document: selecting from a pre-determined list searching or 
by opening a tree structure;
• 9.21 Documents can be linked via a new ‘generated from’ property when they 
are related but one does not supersede the other;
• 9.25 Documents under configuration control do not need SECM approval for 
the ‘Approve’ action. Justification must be given to SECM for the creation of 
requests; 
• 10.2 Changes to the Advanced Search interface; 
Note: screen shots have been updated throughout the Manual.
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v5.3 Approved 04 Jun 2010 One change only, 8.5: Clarification of reviewer selection
v5.2 Approved 30 May 2010 There are 13 changes throughout this version of the IDM Manual.  

The itemised changes are listed on the first page of the document, 
Forward: What's changed since the last IDM update.

v5.1 Approved 15 Mar 2010 • 8.0 Document stakeholders – Communicator icons added 
• 8.6 Disapprove – mandatory comment required

v5.0 Approved 15 Feb 2010 9.23  Restricted Documents (new feature) 
7.1  The field “Abstract or description of a document” becomes mandatory 
9.7, 9.20  Only the approver can make obsolete or supersede an approved 
document 
8.5, 8.6  Permissions checked before setting reviewers and approver of a 
document 
9.8  New button captions for “Send Mail”

v4.1 Approved 07 Dec 2009 Correction of one typing error
Document cover page converted to Forward, listing the release changes

v4.0 Signed 04 Dec 2009 In addition to all layouts changed to reflect new look / feel to IDM,
7.1  Layout of Add New Document is modified with metadata changes such as 
Customzed Field, Contractural Information, OBS etc
8.1  List of approvers changed to line management (previously folder ROs)
8.5  Delegation of Reviewer added
9.22  Modify the Change Description of New Version

v3.20 Approved 22 Sep 2009 In this version the following sections have been added or modified:

5.2.4     IDM document type (new feature)
7.1        New document – added PBS property in screenshot
8.7        RO has project administrator rights locally for own folders (new 
feature)
9.1        Icon showing an obsolete document that has been superseded by 
another (new feature)
9.14      Project administrators can change review before, approve before dates 
(new feature)
9.20      Superseded by link screenshot changed, note added
9.22      Change version description
12.5      Delete version conditions added
13.4      Permission panel image changed, now if ITER and External 
Collaborator are selected, other group will not be shown (new feature)

v3.19 Approved 02 Jul 2009 In this version the following sections have been added or modified:
8.6   -   Approver required to add comment if approval is without complete 
review
9.17 -   Document version change log with cover page, obsolete watermark 
added
9.19 -   A logo to see document in html instead of a link
9.20 -   Superseded by link
9.21 -   Clone metadata
10.1.1  Phrase Search
10.3     Include Full Text Search

v3.18 Approved 04 Jun 2009
v3.17 Signed 29 May 2009
v3.16 Approved 16 Apr 2009
v3.15 Approved 01 Apr 2009
v3.14 Approved 05 Mar 2009
v3.13 Signed 13 Feb 2009
v3.12 Approved 19 Jan 2009
v3.11 Approved 20 Nov 2008
v3.10 Signed 13 Nov 2008
v3.9 Signed 10 Nov 2008
v3.8 Approved 01 Oct 2008
v3.7 Approved 30 Jul 2008
v3.6 Approved 28 Jul 2008
v3.5 In Work 24 Jun 2008
v3.4 Approved 08 Apr 2008
v3.3 Approved 03 Apr 2008
v3.2 Approved 17 Jan 2008
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v3.1 Signed 16 Jan 2008
v3.0 Approved 07 Jan 2008
v2.3 Approved 29 Aug 2007
v2.2 Signed 30 Jul 2007
v1.12 Signed 30 Jul 2007
v2.1 Signed 09 Jul 2007
v2.0 Signed 18 Jun 2007
v1.11 Signed 05 Jun 2007
v1.10 Approved 18 Jul 2005
v1.9 Approved 20 May 2005
v1.8 Approved 18 Apr 2005
v1.7 Approved 24 Jan 2005
v1.6 In Work 17 Jan 2005
v1.5 In Work 14 Jan 2005
v1.4 Approved 08 Nov 2004
v1.3 Approved 07 Oct 2004
v1.2 In Work 06 Oct 2004
v1.1 In Work 05 Oct 2004
v1.0 In Work 04 Oct 2004
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What’s changed since the last approved IDM Manual?

Version 5.12
 7.1 Further modifications to highlight changes in uploading a document 

involving Document Type
 9.22 Clarification of the availability of HTML format of a document
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1 About this Manual

This user manual serves as an introduction to the main features, and to the most commonly 
encountered document management tasks, of the ITER Document Management (IDM) system.
This manual is organised under the following main section headings:
Workplace Overview explains the most commonly used functions, and introduces basic 
document management concepts. New users should start here.
Stakeholders and their Actions describes the roles of the various types of IDM user.
Upload a Document takes the user through the first steps for uploading a new file to IDM. 
Working with Documents guides the user through the subsequent stages of the document 
management lifecycle: how to browse for new versions of a document, how to view old 
versions, and how to associate housekeeping information, or metadata, to a document.
Move, Link, Convert and Delete shows how to move folders and documents within the IDM 
system, how to create links to documents and folders in another area of IDM, and how and 
when to delete a document or folder. 
Search describes the search functions that are provided by IDM, noting the options for full text 
search and advanced search. 
Miscellaneous covers a number of IDM functions and features, including how to maintain 
personal contact information and user preferences.
Throughout this manual, hyperlinks (either within this manual or to other documents) are 
depicted by blue text, and can be clicked on by the user (control + left-click, when reading this 
document in Word). 
Users may access IDM via any standard web browser. IDM was tested on Microsoft Internet 
Explorer and Mozilla. 
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2 Logging in

To log in to IDM, type the IDM server address, https://user.iter.org/idm in your web browser. 
Enter your username and password details in the dialog box, as shown in the following 
illustration, and click on the Log On button.

If a user wishes to change his/her password, the mechanism that is described in the section 13.1 
Viewing your profile, and other users’ profiles can be used.

https://user.iter.org/idm
https://user.iter.org/idm
https://user.iter.org/idm
https://user.iter.org/idm
https://user.iter.org/idm
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3 ICP Home Page

After logging in, IDM either displays the ‘My Area’ page, as shown in the following 
illustration, or goes direct to the IDM Root page, as shown in the following section.
The following illustration of the ICP Home Page shows that it is composed of three frames: the 
Top Frame, the Navigation Frame down the left side (showing your top favourites), including 
the Applications on the lower left side (showing icons for the various applications), and the 
main Display Frame to the right. The display frame lists recently uploaded documents, actions 
(e.g. approval) that you have recently performed, your favorites and the list of items that you 
subscribe to.  More information about these features is given in subsequent sections.

To move from My Area to IDM, click on the green tab: 

To move from IDM to My Area, click on My area, the last item under Applications in the 
lower part of the Navigation Frame:
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4 Workplace Overview

The following illustration of the IDM Root page shows that it is composed of three frames: the 
Top Frame, the Navigation Frame on the left, which includes the Applications area on the 
lower left side (showing icons for the various applications), and the main Display Frame to the 
right.

The Top Frame contains the text box for the search engine, for finding files, folders (and so on) 
in IDM. It also displays the user profile (the user’s name), and a link that leads to the online 
help feature (leading to the on-line version of this user manual). Note that many links and 
buttons in IDM display ‘tool tips’ when the mouse hovers over them. These ‘tool tips’ contain 
additional explanations about the functionality of the links and buttons in question.
The Navigation Frame consists of two areas: the upper frame is labelled “Folders”, and the 
lower is labelled “Applications”. The Folders area is similar in appearance and operation to the 
navigation frame in Microsoft Explorer. Clicking on a document folder displays the folder’s 
contents in the main Display Frame. Clicking on the + icon expands the view of the folder 
(showing its contents). Clicking on the – icon collapses the folder view. The Applications area 
shows the Navigation Menu for the various applications.
The Display Frame shows the content that is related to the folder, application or search that the 
user has just selected. It presents document information such as: the status of the document, 
title, the type of document, size, author and the date of the last modification. Any listed 
document can be downloaded by clicking on the link that includes the unique identifier (UID) 
ie 6 character “number”, also called the IDM number(1A2B3C). To do other work with the 
document, click on the  icon and proceed as described in Working with Documents.
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5 Folders

5.1 Navigation of the folder structure
At its root, IDM has the following folder structure:

Users can navigate by clicking on folders (either in the Navigation Frame, or in the Display 
Frame).
For further information on how to upload a document, see the section on Upload a Document. 
The first few top level layers of the folders (except the Users and Training folders) are pre-
defined by the project management. Lower level folders are managed by a responsible officer 
(RO), who is in charge of setting the access rights to the folders and subfolders. These rights 
are then inherited by any subfolders that they contain, unless access is explicitly set otherwise. 

5.1.1 Main folders (yellow)
Folders, and their ROs, are determined according to the project’s organizational structure.
ROs can delegate authority, and define new responsible officers for each of the subfolders that 
are in their domains. Note that the original (parent folder) RO can always read and write in all 
folders and subfolders of his/her area, even when the RO role has been delegated to other 
people in the subfolders. 

ROs can delete any documents from their areas, though this will not 
completely delete those documents from the system; documents always remain retrievable via 
the search function. (An exception to this rule is that documents in the training folder do not 
appear in search results and are truly deleted after three months).
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Note: A cross on a folder indicates that it is empty.
The Users folder contains several subfolders, organised alphabetically according to the users’ 
login IDs.  Within a personal subfolder, each individual user manages the subfolders and 
documents, and sets the read/write access rights. A document uploaded into a user folder 
cannot have an approver. 
If a user folder has not yet been created for a given user, the user can request its creation in 
Preferences.

5.1.2 Training (grey)
The training folder is grey in colour, and is designed to allow users to practice their IDM skills.  
Within this folder, users have read and write access, can create new folders, and can assign 
read and write access to other users.
The items in this folder are not shown in search results and are deleted by the system after a 
period of three months.

5.1.3 Recycle Bin
This folder contains the documents that have been deleted by users. If a user wants to view the 
deleted document then he/she can view it in this folder, which is sorted according to the year 
and month of the date of creation.

5.1.4 Applications Menu
The Applications menu allows for easy navigation to a different ICP application.

5.2 Creation of new Folders

5.2.1 Setting the title and other standard fields for folders
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To create new folder (within a folder to which the user has appropriate access rights) place the 
mouse over Add, and then click on Add Folder.  A form, requesting the title of the new folder, 
will appear, as shown in the following illustration. As the RO in the parent folder, the user may 
select a new responsible officer for the sub-folder. Fill in the applicable information and click 
on the Save Folder button. The new folder (presently empty) will be opened in the Display 
Frame.

5.2.2 Setting the security rights for folders
ROs can define which read and write privileges in the folder are to be assigned to the various 
user groups by placing the mouse over Edit, and then clicking on Set Security.
To change the security settings, toggle the applicable radio button, and click on Save for your 
changes to take effect.
A user with appropriate access rights can also change the RO of the folder, by selecting the RO 
and then clicking on the Set RO button.
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Clicking on Reset Folder Security to Match Parent Folder resets the current folder security 
according to the parent folder security.
Clicking on Reset Subfolders Security to Match Current Folder resets all the subfolders’ 
security settings as per current folder’s security.
Note: For all folders, view access is automatically granted to the security groups, RO and the 
project administrator.  The project administrator security group allows access to those staff 
who have been specifically nominated in the role of Project Manager for IDM.  

5.2.3Restricting folder access

ROs can change the data and certain settings for the current folder by placing the mouse over 
Edit, and then clicking on Edit Folder. (Alternatively, these data and settings can be made at 
the time that the folder is first created, as described in Setting the title and other standard fields 
for folders).

The RO can define whether shortcuts of the documents and folders inside the current folder are 
allowed.
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If the user selects disallow shortcut for the Restrict Shortcut field, no shortcuts will be allowed 
to be made from the items in this folder, and in its subfolders; the Copy Shortcut button will 
simply not be made visible. Moreover, any existing document and folder shortcuts will be 
deleted, including those in any of the subfolders.
If the user selects allow shortcut for the Restrict Shortcut field, shortcuts will be allowed to be 
made from the items in this folder, and in its subfolders.
If the user selects same as parent folder for the Restrict Shortcut field, the setting for the 
current folder will be made the same as that for its parent folder.
A restricted folder (one in which the disallow shortcut option has been selected) will show the 
Create Shortcut Access comment as shown in the following illustration.

5.2.4 Restricting document type and default document type

ROs can change the data and certain settings for the current folder by placing the mouse over 
Edit, and then clicking on Edit Folder. (Alternatively, these data and settings can be made at 
the time that the folder is first created, as described in Setting the title and other standard fields 
for folders).
The RO should define whether to allow only certain document types inside the current folder. 

As shown in the following illustration, only a restricted list of document types will be available 
for selection.   
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A default document type can be selected for the folder, so that the user does not have to select 
the explicit document type for each document of that folder. (The default document type can 
only be one of the allowed document types).

The default document type will then be selected by default for each new document that is 
created inside that folder, as shown in the following illustration.

The file name extension of file can be pre-defined, by the Document Control Centre (CIE/ 
TI/DOC) based on the document types, so that only valid files will be uploaded for the given 
document type.

5.2.5 Request subscribers
The Responsible Officer of a folder can specify those users who need to be infomed when the 
content of a folder changes, eg the addition of documents to a folder, or modifications to 
documents already uploaded. 

Request Subscribers is used to make a list of those users who need to be informed, and an 
email notification will be sent to each person listed.  Note; this subscription is independent of 
the email setting that may be selected by a user in Preferences.
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6 Hyperlinks

6.1 Creation of Hyperlinks
A hyperlink to a relevant site, or document that is not part of IDM, can be included in an IDM 
folder.  Hyperlinks can be used in order to have a complete set of information or 
documentation which may include documents (or intranet/ internet sites) not contained within 
IDM.  Hyperlinks can also be deleted if they are no longer applicable.
Note: Hyperlinks should not be used to create links of documents stored within IDM.  For that 
Shortcuts should be used, see sections 12.2 and 12.3.
To create a new hyperlink, within a folder to which the user has appropriate access rights, place 
the mouse over Add, and then click on Add Hyperlink.

Fill in the required fields, and click on the Save Hyperlink button.

The hyperlink is displayed as:
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7 Upload a Document

7.1 Uploading a document file and setting its metadata

To upload a document, place the mouse over Add, and then click on Add Document. The Add 
Document wizard starts.

You are first asked to select a Document Type. This selection will be used to display fields, 
specific and mandatory, applicable to the document type.
If the folder is configured with a default document type this first step is omitted and the default 
document type is used.
If the folder is configured with a list of allowed document types, only the List selector will be 
displayed.
This feature allows document types to be used for various business purposes within ITER.
Please ensure that the correct applicable document type is selected. Click the Next button.
Fill in all applicable information (the metadata), browse for the appropriate file on your 
computer, and click either the Save Document or the Save + Load Next button.

List selector Tree structure 
selector



  IDM Manual Page 17 of 72 

Note: 
The red asterisks indicate that certain information is mandatory. The mandatory fields for any 
given document type are managed by a document type’s responsible officer. For example, in 
the screen shot above, the Title while initially not appearing as mandatory becomes mandatory 
with the selection of the document type. The alert to fill in the Title is shown only once you try 
to save for the first time.
Document categories and types can be found in the IDM folder, IDM Configuration: 
https://user.iter.org/?uid=47KERQ .
When saving, you can click on the Save Document  button to save the new document on IDM, 
or on the Save + Load Next button to save the new document and to go on to upload another 
document starting with selecting the Document Type (1/2).
The menu (to add a new document) will only be offered, though, if the user has the necessary 
privileges to upload a document to the given folder.
After an upload has been successfully completed, the document link will appear in the selected 
folder.
Note: Several properties: Document Type, WBS (Work Breakdown Structure) and PBS (Plant 

Breakdown Structure) can be selected either by searching  or by opening a tree structure 

containing the complete list available elements of the property.

https://user.iter.org/?uid=47KERQ
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7.2 Add Attachment
By clicking on the Add Attachment button, the user can attach related documents, or the same 
document in alternative formats, to the current version of the document.
To upload an attachment, click on the  icon to open the metadata page for the document 
version. From here, place the mouse over Add, and then click on Add Attachment.

Alternatively, click on the Add Attachment button (towards the bottom of the document’s 
metadata page as shown in the following illustration).
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Browse for the appropriate document, filling in all applicable information fields and click on 
the Add Attachment button to upload the new attachment file.

The link to the attached file will be shown in the metadata of the given version the document. 
Repeat the whole process if there is more than one file to be attached.
To delete an attachment, click on the  icon.

7.3 Pasting into Text Fields
IDM has a number of text fields, eg uploading a document, version change description, 
comment, Send email, see example: 

Text may be typed into the field or copy/paste can be used.  To ensure that the text is in a 
suitable format (eg correct size of font, spacing) after copying the required text but before 
pasting, click on Source, paste the text in the field, and then click Source a second time.  This 
will remove all font formats, spacing etc and allow you to reformat the text according to your 
needs, eg numbering etc.
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8 Stakeholders and their Actions

Generally, the status of a document version can be:
In work (this is the initial status after upload into IDM)
Signed
Approved
In the workflow process of IDM, various stakeholders are assigned to perform the various 
actions, as described in the following sections. (All stakeholders (that is, authors/signatories, 
co-authors/co-signatories, reviewers, approvers) must be registered IDM users). 
All stakeholders for any given document have a Communicator icon (and link) prefixing their 
names in the metadata of that document.  Any email sent by clicking on this icon will be 
recorded in Outlook, not in IDM history.
The current stakeholders of the document (those of its most recent version) are listed on the 
metadata page, in the section entitled “Document Roles”.  These are the stakeholders who can 
sign, review and approve new and draft versions.

The stakeholders who worked on a version, along with their actions, are displayed in the 
section entitled “Version Signatures”.  These are the stakeholders who performed the actions 
on the particular version of the document, and may not be the same as the current stakeholders.

8.1 Author 
An author can upload new versions of his existing documents. He/she can only upload the 
initial version of a document if he/she has the necessary access rights in the chosen folder.
Provided that no action has been performed on the document version (such as being signed), 
the author can still undo the upload, and completely delete the document version from IDM. 
After an action has been performed, though, the possibility to delete the file from IDM is no 
longer available.
An author can add or remove:
Co-authors
Contributors
Reviewers
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Approver.

When a document is initially created, only a restricted list of potential approvers is offered, 
typically from the author’s line management. A fuller list is offered later, after the document 
has been initially created, by going to its metadata page, and clicking on Change Approver 
from the Edit menu.
When the Author has Signed (by clicking on the Sign button, or by placing the mouse over 
Action, and then clicking on Sign) the current version of his/her document, the date and time 
are shown on the metadata page as shown here:

As a general rule, an Author (or Co-author, Signatory, Co-signatories) of a document should 
not be a Reviewer or Approver of that document.  If, exceptionally, an Author or Co-author, is 
required to also be a Reviewer, the document should be uploaded and saved without the Author 
or Co-Author being selected as a Reviewer.  Only then can the list of reviewers be changed to 
include the Author or Co-Author by clicking on Edit, Change Reviewer and selecting the 
author’s or co-author’s name.

8.2 Signatory
An IDM user can also upload a document on behalf of its real author (who might or might not 
be a registered IDM user). 
Such a person is a signatory, and can add or remove:
Co-signatories
Contributors (in which the name of the real author is usually included)
Reviewers
Approver.

When a document is initially created, only a restricted list of potential approvers is offered, 
typically from the signatory’s line management. A fuller list is offered later, after the document 
has been initially created, by going to its metadata page, and clicking on Change Approver 
from the Edit menu.
When the Signatory has Signed (by clicking on the Sign button, or by placing the mouse over 
Action, and then clicking on Sign) the current version of the document, the date and time are 
shown on the metadata page as shown here (but note, that the signatory might be listed as being 
the author at this stage):

As signatory is not the author of the document, they may be set as “Reviewer” or “Approver”.

8.3 Co-authors and co-signatories
A co-author can add or remove:

Author
Co-authors
Contributors
Reviewers
Approver.
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A co-signatory can add or remove:
Signatory
Co-signatories
Contributors
Reviewers
Approver.

When a document is initially created, only a restricted list of potential approvers is offered, 
typically from the user’s line management. A complete list of IDM users is offered later, after 
the document has been initially created, by going to its metadata page, and clicking on Change 
Approver from the Edit menu.
All of a document’s co-authors (plus the Author), or all of its co-signatories (plus the 
Signatory) must sign the document electronically before IDM will change its status to Signed.
When the co-author has signed (by clicking on the Sign button, or by placing the mouse over 
Action, and then clicking on Sign) the current version of the document, the date and time are 
shown on the metadata page as shown here:

8.4 Contributors
Contributors have no influence on the workflow (and might not even be registered IDM users).
Contributors are listed only to acknowledge their contributions.
Contributors do not sign.

8.5 Reviewers
Reviewers can give comments (when the status of the document version is Signed).  As a 
general rule, a Reviewer of a document should not be an Author, Co-author or Approver of 
that document.  If, exceptionally, an Author or Co-author is required to also be a Reviewer, the 
document should be uploaded and saved without the Author or Co-Author being selected as a 
Reviewer.  Only then can the list of reviewers be changed to include the Author or Co-Author 
by clicking on Edit, Change Reviewer and selecting the author’s or co-author’s name.
 
Reviewers can click on Recommend to indicate that they recommend the current version of the 
document for Approval. The date and time are shown on the metadata page as shown here:

Reviewers can click on Review with comment to indicate that they do not want to recommend 
for approval, or that they want to consider recommending it later. In this case, a dialog box will 
appear in which the Reviewer has to put his/her comments (typically giving his/her reasons for 
not being prepared to recommend the document version for the present), and subsequently the 
document will be removed from the reviewer’s To Do list. The date and time are shown on the 
metadata page as shown here:

A Tooltip containing the reviewer’s comment can be displayed, by hovering the mouse over 
the reviewer’s signature, as shown here:
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A Reviewer can also delegate his/her review task to another IDM user. A Reviewer can use the 
Delegate Reviewer action, which is available in Action menu.

The Reviewer uses the selection screen to select the person to whom he/she delegates his/her 
responsibility to review the document, with the option of sending an e-mail to inform the 
delegate. The stakeholder information (roles) displays the delegated person, as shown in figure 
below:

Once the Reviewer delegates the task, the To Do list of the delegated person shows the task to 
review the document, and the original reviewer’s To Do list no longer displays the task.

The stakeholder information (roles) will show the action performed by the delegated reviewer 
in case of Recommend/ Review with comment  as shown in figure below:
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The delegated Reviewer then has the Review/Recommend action for the document along with 
option to refuse the delegation. The delegation can be refused by clicking the Refuse 
Delegation button. The original reviewer’s To Do list will once again display the task if the 
delegation is refused. Consecutively, the task will be removed from the delegated reviewer’s 
To Do list. In the same way that the stakeholder information is displayed in the metadata, the 
review report and, if selected, the cover page generated for the document will show the 
delegated reviewers’ actions.

Note: When selecting reviewers the system will automatically check that those reviewers have 
access to the document.

8.6 Approver
When the status of the document version is Signed, the approver can Approve the current 
version of the document, or Disapprove it.
An Approver can change the approver (delegation of authority).
An Approver can change the author (and any co-authors).
An Approver can add and remove reviewers.
An Approver can make comments (when the status of the document is Signed).
Only the Approver is allowed to make obsolete an approved document.
Only the Approver and IDM manager can supersede an approved document.
An Approver should not normally be an Author/Signatory, a Co-author/Co-signatory or a 
Reviewer.

After Disapprove has been selected, the stakeholder information will be indicated on the 
metadata page as shown here:

After Approve has been selected, the stakeholder information will be indicated on the metadata 
page as shown here:

An Approver can approve a document without it having been recommended by all reviewers, 
but he/she must then add a comment explaining why the approval action was taken without 
waiting for the complete review process. A dialog box will appear in which the approver writes 
the explanation.

When an Approver disapproves a document it is mandatory for the approver to add a comment 
explaining why the document has been disapproved.

A tooltip containing the approver’s (or disapproved) comment is displayed, by hovering the 
mouse over the approver’s signature in the metadata, as shown here:

When selecting the approver the system will automatically check that that Approver has access 
to the document.
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8.7 Responsible Officer (RO)

A Responsible Officer (of a folder) can:
Define the access rights (read/write) in that folder (and its subfolders.
Define new ROs in subfolders (delegation of responsibility).
Delete documents (links) in the folder of his/her responsibility.
Cut and paste documents to other folders where he/she is also the RO.
Change the approver (delegation of authority).
Change the author, and any co-authors.
Add and remove reviewers.
Make only a non-approved version obsolete.
Make a draft version as a current version.
Convert a document shortcut to a document.
Supersede a non-approved document by other one or more documents.

8.8 Project Administrator
The individuals who are part of the project administrator group are able to access all folders 
and documents within IDM.  All actions by the project administrators are recorded locally in 
the history, ie View History.  The roles and rights of the project administrator within all folders 
in IDM emulate the roles and rights of folder ROs.   

This access is indicated in each folder:
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9 Working with Documents

There is, of course, a correlation between the workflow and the stakeholders, and a consequent 
effect on uploading new versions of a document.

9.1 Status of Documents
The present status of a document is either: In work, Signed or Approved. This is indicated by 
the colour of the metadata information icon. There are also other icons which give other 
information.  The metadata information icons are:

Colour Code Status
 grey Obsolete

 blue In work or Signed

 cyan Approved

 red Disapproved

 green Draft Version

 pink Superseded document

 pointer Shortcut link to a document stored elsewhere on IDM

9.1.1 In work
A document version has the In work status if a new file (or new version) has been uploaded, 
and has not yet been signed (by the author and/or all co-authors).  It is indicated with a blue  
icon.
By ticking the Send Mail box, when uploading a new version of the document, an email 
notification can be sent to selected recipients (for example, the co-authors), thereby requesting 
their signatures. The draft of the email that IDM proposes contains the link to the version of the 
document.

9.1.2 Signed
A document version changes to the Signed status if it has been signed by the author and all of 
the co-authors (if any). It is indicated with a blue  icon.  
By ticking the Send Mail box, at the moment that the last of the author/co-authors signs a 
document version, an email notification can be sent to selected recipients (for example, to each 
of the reviewers). This can be used to request them to review, and/or to request the approver to 
approve the document version. The draft of the email that IDM proposes contains the link to 
the version of the document.
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9.1.1 Disapproved
A document version has the Disapproved status if the approver has disapproved the document. 
It is indicated with a red  icon.

9.1.1 Approved
A document version has the Approved status if the approver has approved the document. It is 
indicated with a cyan  icon.

9.2 Versions

9.2.1 Current version
A new version becomes the current version if the status (In work, Signed or Approved) is equal 
to or higher than that of the previously current version. (In work is the lowest status, Approved 
is the highest).

9.2.2 Draft version
A new version becomes a draft version if the status is lower than that of the previously current 
version. Draft versions of a document are indicated with a green  icon.

9.2.3 Obsolete version
A version becomes obsolete:
If it is superseded by a new current version.  
If it is made obsolete by the author, co-author or approver. To make a version obsolete, go to 
the metadata of the document, and place the mouse over Edit, and then click on Obsolete 
Version. Only the approver of an approved version can make that version obsolete.
Obsolete versions of the document are indicated with a grey  icon.

Note: if a current version is made obsolete, the latest draft version (if there is one) 
automatically becomes the new current version, even if it does not supersede the obsolete 
version in terms of its status. 
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An attempt to access an obsolete version of the document will cause a new screen page to 
appear, as shown in the following illustration.

The user can download the obsolete version of the document by clicking on the Download 
Here link. This is done as a means of getting the user to confirm that he/she really does want to 
download the obsolete version, and at the same time providing information about the current 
version.
Alternatively, the user can choose to access the current version of the document by clicking on 
the coloured  or  icon, or on the text that follows it.
This screen page also shows the Signature Information of all users who have performed actions 
on that version, and any comments, and attachments, that have been added prior to the 
document becoming obsolete.

9.3 Uploading a new version
To upload a new version, click on the  icon (any colour) of the document that is to be 
revised. Only an author, co-author, signatory or co-signatory of a document can upload a new 
version, via the metadata and variety of action buttons that are displayed on their screens. 
Position the mouse on Add, and then click on New Version from the menu, as depicted below.

To indicate the significance of the changes that have been performed on the new version, tick 
either Minor or Major. The decision will be reflected in the numbering of the version:
A minor change will result in incrementing the fractional part of the number (if the old version 
was 1.4, the new version would be 1.5).
A major change will result in incrementing the integer part of the number, and resetting the 
fractional part (if the old version was 1.4, the new version would be 2.0)
If the status of the new version is to be signed immediately, tick the checkbox labelled Sign 
new version.

http://localhost:1347/IWP/IDM/Pages/DocumentView.aspx?uid=CBA50C&version=v2.1
http://localhost:1347/IWP/IDM/Pages/DocumentView.aspx?uid=CBA50C&version=v2.1
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Browse for the file on your computer. In the mandatory Change Description field, on uploading 
a new version of an existing document, indicate clearly and concisely the changes in the new 
version of the document compared to the previous version.  Note: The Change Description can 
be modified only while the new version remains In Work, see section 9.25.
Click on the Submit button, when the fields have been completed, to upload the new version.

The following figure shows the workflow of documents and their versions.

One problem that users frequently encounter is that they know that a new version of a 
document has been uploaded to IDM, but they only seem to be able to find the old version. 
This usually happens because the new version is still only a Draft version (missing the 
signature of at least the author or one co-author). As a result, the old version continues to be the 
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Current version, and hence the one that IDM users find when they navigate to the document 
round the folder structure.
Normally, users are first made aware of the availability of a new version via an email that was 
sent out from IDM. Clicking on the link in that email takes the user directly to the metadata 
page of that version, even if it is still only a draft version.
Alternatively, it is still possible to navigate to a newer, draft version of a document. Having 
navigated to the current version, the user clicks on the icon to see its metadata page, and then 
scrolls to the bottom of this page. The icon for the newer, draft version can be seen at the 
bottom left of the metadata page.

9.4 Add Comment 
To add comments, click on the Add Comment button on the document’s metadata page (at the 
bottom). A pop up page for the comment will open. Type the comment in the large box. 
Comments can be added by stakeholders of the given document, or any IDM user if the author 
has selected All registered IDM users can add comments in the metadata change page.
If an attachment needs to be added at the same time, then Browse for the file. To save the 
comment, click on Save Comment.
Note: The Save Comment button will only appear once a comment has been typed or an 
attachment has been selected.

The comment is displayed on the metadata page of the document, as shown below.

The icon allows an Answer to be added to the comment, as shown below, by the stakeholders 
(or by others, if allowed, as described in the first paragraph of this section).
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9.5 Changing Document Type
Move your mouse over the Edit menu and select the Change of Document Type.

Select the Document Type and click the Save button.

9.6 Changing Stakeholders

To change any of the stakeholders of the document (assuming that you have the appropriate 
access rights to do so), position the mouse on Edit, and then click on the appropriate entry from 
the menu (such as Change Author, Change Co-author, Change Reviewer or Change Approver).
This can also be managed (assuming that you have the appropriate access rights to do so) 
within Edit, Change Metadata, see next section.
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9.7 Changing Metadata
An author, co-author, signatory or co-signatory can change the metadata of a document. To 
change the metadata (such as its title or description) position the mouse on Edit, and then click 
on Change Metadata from the menu. The metadata change page will appear, on which the user 
can change the contents of fields as required. Click on Save Document when all of the required 
changes have been entered.

9.8 Undo and Obsolete a Version
To undo a document version, position the mouse on Edit, and then click on Delete from the 
menu. Only an author, co-author, signatory or co-signatory can undo a version.
Undoing a version is only possible under the following conditions:

 No Action has been performed on the version (Sign, Recommend, Approve…)
 The version is not more than a week old
 Latest version only can be undone (meaning only the last uploaded version)
 No mail for this version has been sent
 No one other than the author, co-author, signatory or co-signatory has downloaded the 

file for viewing.
In order to make a document explicitly obsolete, position the mouse on Edit, and then click on 
Obsolete Version from the menu.
Note: only the approver of the approved version of a document is allowed to obsolete that 
version.

9.9 Send Mail

To send mail, position the mouse on Action, and then click on Send Mail from the menu. This 
will open the compose mail page. Here, the user can change the subject line and the body of the 
mail (by default, the latter contains a link to the document or folder).
Select the users, or groups, in the Receivers field. Extra recipients can be added to the To field, 
and the CC field. (Indeed, the To field should always be checked, that it does not still contain 
the list of recipients of the previous email that IDM sent out for this version of the document). 
Click on the Send Mail button when the message is ready to be sent.
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When changing stakeholders or Uploading a new version of the document, IDM offers the 
option to “Send mail”. This is a separate, though related, mechanism to the one described 
above, and merely entails checking the Send mail check box, and editing the pre-prepared 
email text that is offered by IDM. The user is also prompted to select the recipients for the 
email message, by checking the appropriate check-boxes.

9.10Subscribe
As described in the previous paragraph, stakeholders can be notified of changes to those 
documents that are relevant to them, conditional on the author, co-author or approver having 
decided to send out an email to them following each operation.
If users (with access) wish to be certain that they will be notified of all changes, not just those 
users chosen by the stakeholder making the change, the user can use the Subscribe feature.
To Subscribe to a document, position the mouse on Action, and then click on Subscribe from 
the menu, and then on Yes. A summary e-mail will be sent (daily or weekly according to the 
user’s preference) containing a list of changes to their subscribed documents, that they have 
not already viewed since the changes. The appropriate box Content changes notification in 
Preferences should also be adjusted to the individual’s requirements for the frequency of 
emails received (daily or weekly).

9.11 Document Type Notifications
The IDM manager (currently IO/ ADM/ DOC Section Head) can set up a list of subscribers 
(users or groups) to changes in workflow or version on documents with a particular document 
type. The settings for these notifications are separate to your own subscriptions (see section 
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9.10 above). You cannot unsubscribe from document type notifications, but instead should 
contact the IDM manager. 

9.12 Folder Notifications
The RO of a folder can subscribe up to ten people to receive notifications about documents in a 
given folder (when a new document or version is added or a document is approved).  The 
subscribers are added when creating a new folder or by editing a folder, and setting the Request 
Subscribers property.
Once the subscribers have been added, they will be sent an e-mail informing them that they 
have been registered as subscribers to the documents inside the folder.  
Note: 

 Users will not receive any notification e-mails until they activate the folder, see 9.12.1.
 Users will receive notifications about changes to documents in that folder and sub-

folders. Below is the list of events that are currently available to initiate notification:
o Folder Document Creation;
o Folder Document Version Creation;
o Folder Document Version Approved.

9.12.1Activating Folder Notifications
If you have been added as a subscriber for folder notifications, you must activate the 
subscription to start receiving notifications. To do this, on the IDM home page (My Area), 
underneath the list of your subscribed items, is a link for “Manage IDM Folder Subscription” 
(bottom right of the page).

Follow this link, then you can activate or de-activate any of your folder subscriptions by 
checking the boxes and then pressing Save Settings:

Notifications are sent according to your subscription preferences (see Section 9.10).
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9.13 Show Path
By positioning the mouse on View, and then clicking on Show Path from the menu, the full 
path of the current document or folder is given, along with the full paths of any shortcuts to the 
same document or folder.

9.14 View History
By positioning the mouse on View, and then clicking on View History from the menu, the 
history is given of all of the actions that have been performed on the document (within IDM). 
By default, the history is sorted in reverse chronological order. To sort it on one of the other 
fields, click on the header of that field (and click again to toggle between sorting in ascending 
or descending order).

9.15 Export to Word
By positioning the mouse on Action, and then clicking on Export to word from the menu, the 
contents of the document are exported to a word file.

9.16Add to Favorite
Putting the mouse over Action and then clicking on Add to Favorite causes the item to be 
added to the user’s list of Favorites. If the item is already in the user’s list of Favorites, the 
option will be offered to Remove from Favorite, instead. Items in the list of Favorites are 
shown on the Home page for ease of reference.

9.17 Scheduling of Workflow
The approval process has been automated, and a policy for the approval of documents has been 
implemented, so that notifications are sent about the status of document versions, including 
information on requested and performed actions by the staff involved in the workflow process.
When any document is uploaded, the author and co-authors are encouraged to sign it within 
7 days. If they fail to do so, they are sent email reminders, once every week thereafter. The 
Sign before date is shown in the metadata, as depicted in the following image.  

Authors and co-authors can choose to extend this Sign before date by choosing the Reschedule 
option, as shown below.
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By clicking on Reschedule, an author or co-author can delay the Sign before date so that 
reminders will not be sent before this new date. A mandatory explanation must be given by the 
author or co-author when rescheduling. 
 

After the author and all co-authors have signed, an email can be send to the reviewers to review 
and recommend the document version. The review process should be completed within 14 days 
following the last of the author/co-authors’ signature(s). This date of Review before is shown in 
the metadata, as depicted in the following image.   

Any reviewers who fail to review the document within 14 days are sent an email reminder, 
repeated weekly thereafter.
By positioning the mouse on Edit, and then clicking on Reschedule from the menu, a reviewer 
can delay the review date, and reminder emails will not be sent before the new date. A 
mandatory explanation must be given by the reviewer(s) when rescheduling.
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After the author and all co-authors have signed, and all of the reviewers (if any) have 
recommended the document version, an email can be sent to the approver, directing him/her to 
approve the document within 14 days. The Approve before date is shown on the metadata page, 
as depicted below.

If the approver does not approve the document within 14 days, an email reminder is sent, and 
then weekly after that.
By positioning the mouse on Edit, and then clicking on Reschedule from the menu, the 
approver can delay the approval date, and reminders will not be sent before the new date. A 
mandatory explanation must be given by the approver when rescheduling. 

Only the project administrator can reset the sign before, review before and approve before 
dates, of any document, to a date earlier that the automatically set date.

9.18 Report on the Approval Process
A report can be generated to summarize the status of the approval process for a document 
version. Any stakeholder (the Author, Co-Authors, Reviewers or Approver) can generate this 
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report by positioning the mouse on Action, and then clicking on Generate Report and Send by 
Email, as depicted below:

The report provides the following information:
 UID (a unique identifier, also called the IDM number), current status, current 

version, and so on.
 Chart that displays review/recommend statistics.
 All comments that are associated with the version
 All users who have specific roles on the document version.

This generates the report, and takes the user to a mail page containing the link to the generated 
report. The user can then set various mail options, such as recipients, and subject. A few 
images of sample review reports are shown in the following illustrations.
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Instead of having the report sent by email, it is possible to view it on the screen by selecting 
View Report on the View menu, as indicated in the following image.

The report can be exported in MS Excel or PDF format. The export options are available at the 
top of the report, as shown below:

9.19 Delayed Action Report
This report is generated for all users who have pending actions (Sign, Review, Recommend, 
Approve). The report is generated weekly, and is sent to the corresponding person 
automatically by email. The report lists all pending tasks and also provides hyperlinks to the 
documents. A sample report is shown here:
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9.20 Cover Page Generation on Document Version
A cover page can be generated for *.rtf, *.doc, *.docx and *.pdf files, and is mandatory for all 
baseline document types.
The following illustration shows a section of the change metadata page that is displayed when 
editing the metadata of an existing document (by placing the mouse over Edit, and then 
clicking on Change Metadata), or else at the time that the document is first uploaded (by 
placing the mouse over Add, and then clicking on Add Document).
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Authors or Signatories of the document can tick the Auto Generate Cover Page? check-box, 
and subsequently click on the Save Document button. This causes a new option, Update cover 
page, to be added to the Action menu, as shown in the following illustration.

There are two ways to generate a cover page for the document:
1. On Demand (using the Update Cover Page menu item)
2. System generated

9.20.1 On Demand
By placing the mouse over Action, and then clicking on Update Cover Page, the process starts 
to attach the default cover page to the document. When the process is complete, the user 
receives the following message:

When the user next clicks on the document title, to view the pdf version of the document, a 
cover page will have been attached, as shown in the following example.
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The history of changes for the document is added on the page following the cover page:
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After the cover page has been generated, the RO, Author and Project Administrator will also 
see the Remove cover page option on the Action menu, as shown in the following illustration.
The option of a cover page can be removed by unchecking the Auto Generate Cover Page? 
check-box in Edit, Change Metadata. 
End user cannot change the document template for the cover page. This is done by Document 
Type Category Responsible Officer. It is done by selecting one from the list, as shown in the 
following illustration. If none is selected, the default cover page will be used.

Once a document has been created with an automatic cover page, the document is 
viewed/downloaded as a pdf.  The original document type (ie *.rtf, *.doc, *.docx and *.pdf 
files)  is available only to the stakeholders of the document, to be used for a new version, or for 
making comments during review or disapproval process.
Obsolete Water Mark
Once such a document has been made obsolete, a water mark “Obsolete” will be displayed on 
all the pages of the document, as shown below.

https://user.iter.org/?uid=2YJ4Q6
https://user.iter.org/?uid=2YJ4Q6
https://user.iter.org/?uid=2YJ4Q6
https://user.iter.org/?uid=2YJ4Q6
https://user.iter.org/?uid=2YJ4Q6
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9.20.2 System generated 
If the user does not create the cover page manually, the system will automatically generate one 
after several minutes. The cover page is updated each time a change is made to the document 
metadata, or when a stakeholder signs, recommends/reviews or approves the document version.

9.21 Private for Stakeholder
This feature allows a document to be made private to the stakeholders: only stakeholders will 
be able to see the metadata page, or to access the View History information.
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The following image shows a section of the page that is displayed when editing the metadata of 
an existing document (by placing the mouse over Edit, and then clicking on Change Metadata), 
or else at the time that the document is first uploaded (by placing the mouse over Add, and then 
clicking on Add Document).

9.22 View HTML format of document

This feature allows the user to view certain types of document (those uploaded with “.doc” or 
“.docx” extension) as HTML files. A document that is converted to a “.pdf ” as a result of 
selecting Autogenerated cover page will also be available in HTML format.  Clicking on the 
icon, as shown in the illustration above, quickly opens the HTML format of the file if required.

9.23 Metadata links: Superseded By
A document stakeholder can position the mouse on Action, and then click on Superseding Link 
from the menu, as shown in the illustration below, to indicate that the document is to be 
considered obsolete and superseded by another.

Select the documents that are to be shown as superseding this document, and click on the Save 
button. (One or several documents can be selected). 
Note: only the approver of the approved version of a document is allowed to supersede that 
version with another document.  For document with status, In Work or Signed, only the RO of 
the folder containing the document to be superseded can supersede one document by another.
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The “Obsolete Document” page will then indicate that this document has been superseded, and 
by which documents.

The superseding documents will also show in their metadata the new information about the 
superseded document, as shown in the following illustration.

Note: The “Superseded by” link is not available in version 0.0, as there is no file.

9.24Metadata Links: Generated From
In some cases a document has been generated from another document, but does not supersede 
it.
In such situations, the generated document can have the link of the original document in the 
field Generated From located in the ‘Additional Information’ section of the metadata.
To set this property while uploading a new document, edit the field in Add, Add document.
To set this property for an existing document, edit the field at  Edit, Change Metadata.
Note: The UID of the linked document must be known before making the search.
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This property has a reciprocal nature.  In the metadata of documents selected in the field 
Generated From, there will be an extra field created automatically entitled Derived Documents. 
Here will be listed the documents that have been generated from the original document.

9.25Clone Metadata
This feature allows users to make a copy of the metadata. Click on Clone metadata in the 
Actions menu of document’s metadata view page as shown here:

This menu will be available to users who can “add” documents in the folder of the current 
document.
By this method the complete metadata of the displayed document will be copied except the uid 
and file itself.
A new page will be opened as shown here with all the copied data filled in.



  IDM Manual Page 48 of 72 

The user can change the metadata where necessary, and can upload a new file and save the 
document.
The new document will be created in the same folder.

9.26Modifying Change Description of New Version
When a new version of a document is uploaded, an explanation of the changes from the 
previous version is mandatory in the field, Change description on new version. This field can 
only be corrected by the author/signatory for the period that document remains In Work, see 
section 9.3.
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9.27Restricted Documents
Restricted documents are documents which are placed in a Restricted folder. The restricted 
folders can only be accessed by members of the Global Group: IO_Restricted. 
A document can be made restricted by setting the “Is this document restricted” property of 
document to true. A restricted folder will be identified by “r” suffix. If a document is made 
restricted then its restricted folder will automatically be created and the document will be 
moved into that restricted folder.

The icon to identify the restricted folder is .  The document is allowed to be a restricted 
document only if all stakeholders of document are part of GG: IO Restricted group. The 
restricted folder will have only View access.
The security of a restricted folder will be the intersection of the parent folder security and GG: 
IO Restricted group members, so that only common members will be able to see the restricted 
folder and its contents.  The membership of GG: IO Restricted will be controlled and managed 
the Section Head of SAS/SCD/SEC.

9.28Next Expected Version Date
This property indicates the date on which a new version of a document should be produced.  
The purpose is to assist the submitter to manage the document. In general this is not a 
mandatory field, although it could be selected as mandatory for specific document types.   The 
property can be selected as part of the metadata when uploading a new document, or after the 
upload has been saved in Edit/Change Metadata. 

Setting a date for this property will enable you to be notified via the To Do list.

http://fr-iws-iisdev.iter.org:10000/IDM/Pages/DocumentSystem.aspx?uid=744084
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If you wish to remove the date, click Clear from the end of the calendar.  This will also remove 
Upload New Version as a Requested Action for that document in your ToDo list.
When you upload a new version this property is reset by the system to no date. If required, you 
would  need to set a new date yourself in Edit/ Change Metadata.

9.29Documents under Configuration Control
A document comes under configuration control when its document type is a configuration 
controlled type.  Document types under configuration control are clearly labelled: “(Under 
Configuration Control)”.
Documents under configuration control are listed with a padlock icon:

When under configuration control, the actions “Change Document Type” and “Add New 
Version” must be validated by the configuration control manager before being carried out.  In 
order for an action to be validated, a request must first be submitted.  These requests are only 
valid for the user who submits them.
This additional workflow step is reflected by a change in the action name, for example Add 
New Version becomes New Version Request, and is only available from the Add menu. 

If a request has already been submitted, this option will be replaced with the ability to view the 
request:

When creating a request, justification must be given for the action.
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If the configuration manager approves the request then the action will be available as usual on 
the document, for the user who created the request.
If the configuration manager refuses the request, the View Document Approval Request remains 
visible, and the action is not available.  The configuration manager may approve a disapproved 
request at a later date.

9.29.1New Version Requests
After a new version request has been approved, the Add New Version action is available until 
one of the new versions has been Approved.
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10 Search

10.1 Simple Search

The search engine performs a simple search for any text string that is typed into the Search box 
(as in the example above, searching for the UID “22223j”). The search engine searches for this 
text in the metadata of each document to which the user has read access (on the IDM system). 
That is, it searches for the text within the following fields of each document: the UID, the title, 
the description, the author, the contributors, the co-authors, the reviewers, the approvers, the 
status, the workflow, the external number, and the document type.
Click on the magnifying-glass icon, as shown below, to start the search. IDM performs the 
search, and returns a list of applicable documents and folders.  

10.1.1 Phrase Search

In Search, “IDM Manual” and “Manual IDM” will produce same results, as shown here.
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The closest match to the word(s) searched is displayed first.  
In addition the results can be further refined according to the type of ICP entry, eg Design 
Work Orders indicated on the right hand side of the screen will then reduce the original list to 
display only Design Work Orders.
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10.2Advanced Search
A finer control of the search engine is possible with the Advanced Search feature of IDM. This 
performs the search only on selected metadata fields.
Click on Advanced Search in the Top Frame, right hand side. 

A template with several search options will appear. Place the cursor on the metadata item to 
which you wish to add a filter, and select (Search condition) and fill in (Search value) the 
relevant information.  Then press Add Filter to add the filter to the search, and repeat with any 
other metadata item.
The check boxes (left of the list of metadata items) can be ticked to select the metadata 
information that will be provided for each document found as a result of the search.

The advanced search can also be used to create, and save Reports. The user can search by 
selecting the Metatype from the drop-down menu, such as Document, Folder, and Tickets. If 
the user wants to save the search reports, they should do so from the results page (as indicated 
below):



  IDM Manual Page 55 of 72 

10.3Full Text Search
It is possible to conduct a search for a given text string within the body of documents. To do 
this, the user first needs to perform a simple search, as described above (which, of course, only 
searches for the text string within the metadata fields). Then, when the search results are 
displayed, he/she can tick the checkbox labelled Include Full Text, and then click on the button 
labelled Search again for à.
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11 Security Settings

11.1Giving Permissions to Groups
Security can be set on folders in IDM.  To change the security of a folder (where you are the 
RO) select Edit > Set Security from the menu when viewing the folder.  You will be presented 
with a view showing which groups are currently assigned permissions:

You can change the permissions granted to these groups by selecting the appropriate column 
(Add, View or None) and then pressing the save button.
To grant permission to another group, use the Group Name search box to find the group, select 
the appropriate permission level and then press the save button:

You may use the tree selection by clicking on the dedicated icon as shown below:

A new window is opened which allows you to select the correct group by browsing the tree 
structure.
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Once the group is selected, you must apply your security settings.

If the name of the group is not known, or if you wish to view all the possible groups, then 
clicking on Show All Groups will display all AD, GG, and relevant LGs (for that folder), see 
below.
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11.2Local groups
IDM defines certain major groups of IDM user, and allows the user to set their read and write 
access rights on any folders for which that user is the RO, or the RO’s trusted person (an 
authorised delegate).
In addition, the local group feature allows read and write access rights to be set for custom-
defined groups of IDM users. This involves doing the following:
Within the appropriate folder, click on Edit, and then position the mouse over Action, and click 
on Set Security
Click the Create Local Group button, give a name to the local group, select the access rights, 
and double-click on those users who are required as members of the Local Group.
Fill in the appropriate fields, and click on the Save User Group button.

To change members of a local group:
Click on the Pencil icon, as shown below.

Note: Local groups can also be used as a mechanism for taking away read and write access 
privileges from certain users.  
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11.3 Trusted Person
Through the trust-giver/trust-receiver system, the trusted person feature allows IDM users to 
delegate all user rights and authority to another trusted IDM user. The trusted person must first 
be set up by the user who is giving the trust, and may be for any (long or short) length of time.

To control and make use of this feature, click on the Preferences button on the top frame. 

11.3.1 Trust-giver
To allow another IDM user to work on your behalf, in the trusted person field click, on the 
blue icon, and select the appropriate user(s), as indicated in the illustration, below.

11.3.2Trust-receiver
To work in behalf of another person, click on the name of the user from the drop-down list in 
the field Work for, and then click on Save.
In the Top Frame, next to user’s name, the name of the selected trust-giver will appear, 
indicating for whom it is that the user is working.

To return to working on your own account, click on [Remove], or else repeat the above 
process, selecting ---me--- from the drop-down list and click on Save.  The removal of the 
‘working for’ is not automatic on closing the browser, or shutting down the computer.  It must 
be removed.
When removing delegation, you will be returned to either the page that you were last viewing 
(if you still have permission to view it) or to the page that you were viewing immediately 
before working as trust-giver.
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12 Move, Link, Convert and Delete

12.1 Cut-and-paste for documents and folders
This enables a document or folder to be moved from one area to another:

1. Go to the folder that currently contains the documents and sub-folders to be moved 
(as depicted in the illustration above).

2. Each document and sub-folder has a check-box associated with it, in the left-most 
column of the display frame (as shown in the illustration). Tick those (by clicking on 
the check-box) that are to be moved. (One, many, or all may be selected).

3. With sufficient access rights, there will be a Cut button among the buttons along the 
bottom of the frame. Click on the Cut button.

4. Now go to the folder in which the chosen documents and/ or sub-folders are to be 
pasted.

5. With sufficient access rights, there will be a Paste button among the buttons along the 
bottom of the frame. Click on this Paste button.

12.2 Create Shortcut for documents 
1. Go to the folder that currently contains the documents and sub-folders that are to be 

linked (as depicted in the illustration at the start of this chapter).
2. Each document and sub-folder has a check-box associated with it, in the left-most 

column of the display frame (as shown in the illustration). Tick those (by clicking on 
the check-box) that are to be shortcuts in another folder. (One, many, or all may be 
selected).

3. With sufficient access rights, there will be a Create Shortcut button among the 
buttons along the bottom of the frame. Click on this Create Shortcut button.

4. Now go to the folder in to which the chosen documents and/ or sub-folders are to be 
pasted.

5. With sufficient access rights, there will be a Paste button among the buttons along the 
bottom of the frame. Click on this Paste button. The shortcuts are depicted with a 
dark arrow on their  icon for a folder and  for a document shortcut.

6. Create Shortcut will not be available if the folder is restricted for shortcuts as shown 
below. 
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12.3 Creating a shortcut to a folder 
1. Go to the folder that currently contains the sub-folders to which shortcuts are required 

(as depicted in the illustration at the start of this chapter).
2. Each sub-folder has a check-box associated with it, in the left-most column of the 

display frame (as shown in the illustration). Tick those (by clicking on the check-box) 
that are to be shortcuts in another folder (One, many, or all may be selected).

3. With sufficient access rights, there will be a Create Folder Shortcut button among the 
buttons along the bottom of the frame. Click on this Create Folder Shortcut button.

4. Now go to the folder in which the shortcuts to the chosen sub-folders are to be pasted.
5. With sufficient access rights, there will be a Paste button among the buttons along the 

bottom of the frame. Click on this Paste button. The shortcuts are depicted with a 
dark arrow on their  icon.

6. Folder shortcuts will not be available if the folder is restricted for shortcuts, as shown 
in the illustration in the previous section. 

12.4 To convert a shortcut/document
Any number of shortcuts can be made of a document (or folder), each one of which will appear 
with the appropriate pointer  icon. The original document (or folder), though, will still 
appear with the normal icon. The Convert To Document button enables a document shortcut to 
be made into being the original document with  the “original” original one being turned into the 
shortcut:

1. Go to the folder that contains the shortcut to be converted (as indicated by the pointer 
 icon).

2. It has a check-box associated with it, in the left-most column of the display frame. 
Tick this (by clicking on the check-box).

3. With sufficient access rights, there will be a Convert To Document button among the 
buttons along the bottom of the frame. Click on this Convert To Document button.

4. This folder will now contain the main (or original) document, as indicated by the 
usual icon, and the original document will now be converted into shortcut, with the 

 icon.

12.5 Delete
1. Go to the folder that contains the documents that are to be deleted.
2. Each document and sub-folder has a check-box associated with it, in the left-most 

column of the display frame (as shown in the illustration at the start of this chapter). 
Tick those documents (by clicking in the check-box) that are to be deleted. (More 
than one document can be selected at a time and deleted).
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3. For the Responsible Officer of the folder (or any parent folder) containing the 
document / document shortcut to be deleted, there will be a Delete button among the 
buttons along the bottom of the frame. Click on this Delete button.
This can also be used to delete sub-folders (in which case, the corresponding 
shortcuts will also be deleted).

There is also a facility to delete a document version from document metadata view page. To 
use this, place the mouse over the Edit menu, and click on Delete. 

However, this menu will appear only if:

1. No action has previously been performed on the document version, such as being 
signed

2. The document version is not more than one week old
3. The person attempting the operation is the author, co-author, signatory or co-

signatory
4. The version number is not 0.0.
5. There is more than one version, and the version to be deleted is the most recent one
6. No email has been sent from the metadata page of the document version
7. No-one except the author, co-author, signatory or co-signatory has downloaded the 

version’s file

12.6 Copy Folder Structure
Note: This option may only be carried out by a Project Administrator.
This enables a folder structure to be copied from one area to another:

1. Go to the folder that contains folders and sub-folders that are to be copied.
2. Each folder has a check-box associated with it, in the left-most column of the display 

frame (as shown in the illustration at the start of this chapter). Tick those (by clicking 
on the check-box) that are required to be copied (One, many, or all may be selected).

3. With sufficient access rights, there will be a Copy Folder Structure button among the 
buttons along the bottom of the frame. Click on this Copy Folder Structure button.

4. Now go to the folder in which the chosen folders and sub-folders are to be pasted.
5. With sufficient access rights, there will be a Paste button among the buttons along the 

bottom of the frame. Click on this Paste button.
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13 Miscellaneous

13.1 Viewing your profile, and other users’ profiles 
To view the details of your personal profile, click on your name in the Top Frame. From here, 
details can be checked (such as your email address, telephone number, office number, IDM 
group memberships).
If a change of password or any of personal details is required, click on the Self Admin button. 
The system will first demand your present password, and will (assuming that the security check 
is passed) then display a page listing First Name, Last Name, Email address, Office number 
(building/room), Phone number, and Fax number. The first three cannot be changed directly, 
but a hyperlink is still offered to Send a Change Request to the Windows Admin staff to 
consider performing the change. The last three, though, can be changed directly by the user, by 
clicking on the Change button. The login password can also be changed in this way.
These changes, including that of password, will take effect for all of the ITER computing 
systems that are connected on the main network. Indeed, clicking on the Self Admin button 
takes you to the network address that can be, alternatively, accessed at any time by typing 
https://www.iter.org/selfadmin as the address for your web browser.

If you wish to add a photo of yourself in this area using the webcam, go to 
https://user.iter.org/?uid=2EHCB5 . This photo will appear above the Groups box on the right hand 
side. The photo will also be accessible from the ITER Phone Book, where a blue icon denotes 
that a photo is available, and a yellow icon indicates that no photo is yet available.
To view another user’s profile, click on the View Other Users Profile button. A pop-up page 
will appear, like the one shown below. Search for the required name, and select it (either by 
double-clicking on it, or by using the >> button) and then click on the Apply button.

https://www.iter.org/selfadmin
https://user.iter.org/?uid=2EHCB5
https://user.iter.org/?uid=2EHCB5


  IDM Manual Page 64 of 72 

Click on the View all items in which you are RO button to obtain a list of the folders for which 
the user is the RO.

13.2 Preferences

To change your preferences, click on the Preferences button, on the top frame.
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Here, the maximum number of files that are to be listed in the display frame can be specified, 
and also the number of files to be returned whenever a search with the search engine is 
performed.
To create your own Users folder, click on the Request button. This button will not be offered if 
the folder already exists for you.
You can select sort order, for the Favorites list, from the drop-down list for sorting by Title, 
Creation date, or Last modification date.
Clicking on the Manage Subscribed Items button takes you to a page that lists the documents 
that are presently being tracked for you.
You can select to Receive email daily or Receive email weekly, or, by default, No email.
You are allocated, in advance, a list of UIDs (that are used, for example, when creating a new 
document or folder). These can be viewed in the Allocated UIDs drop-down list. Clicking 
Request for New UIDs forces IDM to discard these, and to allocate a fresh set.

13.3 To Do
In order to see the current To Do list (that is, those documents for which your action is 
required); click on the To Do button on the Top Frame.

If you want to clear the documents from your To Do list, tick the required check-boxes, then 
click the Remove from To Do List button. The selected documents will not appear again in the 
To Do list. However, note that documents will still appear on the Delayed Task Lists of 
stakeholders if the actions required are not completed within the due date.

13.4 Permission Panel

The permission panel is normally already displayed in the display frame. It shows the link and 
the path of the folder/document.  For folders, it shows the groups that have View access and 
Add access to that folder (users with Add access also have View access).  For documents, it 
shows the users that have view access to the document.  Each group is represented as a 
hyperlink. Clicking on this will show the members of that group. If both the groups: ITER and 
External Collaborator are selected, no other sub group will be allowed as all IDM account 
holders must be a member of one of these two groups.
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13.5 Mass Download Utility

The Mass Download utility is available by positioning the mouse on Action, and then clicking 
on Mass Download. It can be applied to any folder that is at least in the third level of the IDM 
folder tree.
Note: this utility works with Internet Explorer and is not available for other browsers.

In the Mass download page, the “Download three levels of sub folders” checkbox, if checked, 
allows the user to download, to your local hard disk, the content of the folder and that of sub- 
folders down to three levels. Otherwise only the documents of the current folder are 
downloaded.

 
Clicking the “click to download button” will pop up this window and process the download of 
documents. Once finished, the Open local folder button opens an explorer window showing the 
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downloaded files. The current folder will be downloaded in “My documents” of your 
computer, as shown in following figure.

Only current versions or drafts are downloaded.
If a new version of a document has been added, a subsequent use of the mass download utility 
on the same folder will replace the old version by the new one, and delete any documents that 
have become obsolete. 
It is also possible to flag IDM folders (when creating a folder or by clicking on Rename folder 
in the Edit menu) to allow users to download files with their original file names. To do so tick 
the check-box labelled “Allow original file name download”.

For the given folder, the mass download page will now display an additional check-box 
“original file names” as shown in following figure.
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13.6 IDM Quick Navigation 
IDM Quick navigation is available in the navigation tree if the green button  on the left side 
is visible. If so, click the button and the navigation tree is expanded.

In the navigation tree itself, you can view the metadata page of the document by clicking on the 
 icon. To see the Microsoft Office documents, text, PDF files in the right frame, click on the 

title of the document in the navigation tree.
If you are not able to view the Microsoft Office documents in centre frame then visit this link: 
http://www.tutorialized.com/view/tutorial/Configure-Internet-Explorer-to-open-Ms-Office-Word-Excel-Power-
Point-Etc-documents/32780 for configure the Microsoft office 2007 documents to be viewed in the 
centre frame.     

http://www.tutorialized.com/view/tutorial/Configure-Internet-Explorer-to-open-Ms-Office-Word-Excel-Power-Point-Etc-documents/32780
http://www.tutorialized.com/view/tutorial/Configure-Internet-Explorer-to-open-Ms-Office-Word-Excel-Power-Point-Etc-documents/32780
http://www.tutorialized.com/view/tutorial/Configure-Internet-Explorer-to-open-Ms-Office-Word-Excel-Power-Point-Etc-documents/32780
http://www.tutorialized.com/view/tutorial/Configure-Internet-Explorer-to-open-Ms-Office-Word-Excel-Power-Point-Etc-documents/32780
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There is also a facility for you to view Word documents in HTML format when the IDM Quick 
Navigation is on, by clicking on the download links of the document in the navigation tree, and 
also in the metadata page of the document.
To deactivate this navigation feature, click on the red button  

13.7What’s New
A “Subscribe” link is available in the right hand end of the Top frame. This is used to obtain 
the latest ICP News. Whenever anything new comes in ICP, a description of it is displayed on 
this News page. The following image shows where to find this “Subscribe” link.

The following image shows the appearance of the news page.

In this page, there is also an RSS link. To subscribe to this RSS feed, to receive up-to-date ICP 
News, copy the given URL of the page into your RSS reader.

13.8 Personal Notes
To create a personal note within a folder (or document) to which you have View access rights, 
position the mouse on Add, and then click on Add Note.
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After saving the note, it will be displayed in a yellow box in the bottom right corner, as shown 
below.

To edit the note, click on the   icon, and to delete the note, click on the icon.
The note can be closed by clicking on the  icon in the yellow box. 
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The position of the note can be adjusted by putting the cursor over its blue bar and dragging it.
A Personal Note can be viewed again by positioning the mouse on View, and then clicking on 
View Note. The note will be displayed again in the bottom right corner.
Note: Personal Notes are only visible to the user who created them. No user can view another 
user’s personal notes.

13.9 View Action Log
Under certain conditions, a log can be obtained of the actions that have been performed on a 
folder or document, by placing the mouse over View, and then clicking on View Action Log
This function is only available for the Responsible Officer of the current folder, provided that 
the folder is at the third level (or lower) in the IDM folder tree.

This causes a page to be opened, as shown in the following example.

The user can select a Start Date and an End Date before clicking on the Generate Report 
button.
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The log summarises the view and download actions that have been performed by members of 
each of the various IDM user groups.
By ticking the Show Full Tree Log? check-box, before clicking on Generate Report, the log is 
extended to include actions that have been performed on the sub-folders of the current folder.

13.10 Security Report
A report, showing the security settings of the current folder, is available to the Responsible 
Officer of the current folder, provided that the folder is at the third level (or lower) in the IDM 
folder tree.

By placing the mouse over View, and then clicking on Security Report, the report is generated, 
in the form of an Excel file, as shown in the following example. The security settings are 
shown not only of the current folder, but also any sub-folders that it contains.


